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Georeferencing

Before Getting Started
This Getting Started booklet introduces the techniques for adding geographic
control to your project materials.  You will use this Georeference process to define
the map projection, location, and scale of your geodata objects.  Adding georef-
erence information creates geographically interrelated objects (e.g., geodata sets).
The TNT products automatically relate georeferenced objects to each other when
they are displayed, measured, combined, mosaicked, and otherwise manipulated.
Accurate georeferencing of your objects is an important step in preparing your
geospatial materials for further use in the TNT products.

Prerequisite Reading  This booklet assumes that you have completed the exer-
cises in Displaying Geospatial Data and  Navigating tutorials.  Those exercises
introduce essential skills and basic techniques that are not covered again here.
To find out more about Map Projections, read the associated tutorial,  Map Pro-
jections.

Sample Data  The exercises presented in this booklet use sample data distrib-
uted with TNT products.  If you do not have access to a TNT products CD, you
can download the data from MicroImages’ web site.  In particular, this booklet
uses the objects in the CB_COMP and CB_DLG Project Files in the CB_DATA data
collection.  Make a read-write copy of the sample data on your hard drive; the
exercises will not work if you use the read-only sample data on the CD-ROM.

More Documentation  This booklet is intended to be only an introduction to
Georeferencing.  Consult the TNT online reference manual, which includes over
55 pages on the Georeference process, for more information.

TNTmips and TNTlite™  TNTmips comes in two versions: the professional ver-
sion, and the free TNTlite version. This booklet refers to both versions as
“TNTmips.”  If you did not purchase the professional version (which requires a
software license key), TNTmips operates in TNTlite mode, which limits the size of
your project materials and enables data sharing only with other copies of TNTlite.

The Georeference process is part of TNTmips and TNTedit.  It is not available in
TNTview or TNTatlas.  All the exercises can be completed in TNTlite using the
sample geodata provided.

     Keith Ghormley, 26 September 2003

It may be difficult to identify the important points in some illustrations without
a color copy of this booklet.  You can print or read this booklet in color from
MicroImages’ web site.  The web site is also your source for the newest
tutorial booklets on other topics.  You can download an installation guide,
sample data, and the latest version of TNTlite:

http://www.microimages.com
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STEPS
select Edit /
Georeference from the
TNTmips menu
select File / Open and
select LITEDATA / CB_DATA /
CB_COMP / _16BIT_RGB

click [Skip] in the Select
subobject dialog
click [OK] in the
Georeferencing Options
dialog to accept the Lat-
Lon coordinate system
click [OK] to close the
message dialog about
the limitations of the Lat-
Lon system

The Georeference process lets you create and store
control information that relates raster cells or vector,
CAD, or TIN elements to a coordinate system and
map projection.  TNTmips keeps the coordinate val-
ues for your control points and related parameters
in a georeference subobject.

For our initial exercise, begin by selecting Edit /
Georeference from the TNTmips menu.  Select File /
Open from the menu in the Object Georeferencing
window and open the LITEDATA / CB_DATA / CB_COMP

/ _16BIT_RGB raster object.  For these exercises we
will use the Lat-Lon coordinate system.  Lat-Lon is
the simplest system, but it is not a true map projec-
tion, and so has significant disadvantages for many
uses.  Refer to Getting Started: Map Projections for
important background information.

The exercises on pages 3-5
of this booklet show you
how to select an object, a
coordinate system, and
other projection parameters.
Exercises on pages 6-9
introduce techniques for
adding, editing, and deleting
control points.  Other topics
are introduced on pages 10
through 15.

The crosshair tool is selected in the Input Object
View window in the Add mode

Starting the Georeference Process
Once you have
georeferenced a geodata
object in any projection
system, then it will relate
correctly to all of your other
project materials no matter
what system they use for
georeference.  All of the
TNT products automatically
reconcile the georeference
control and map projections
of all project materials.

In the following exercises, you
will place the crosshair on
features that will serve as
georeference control points
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One of the easiest ways to establish georeference is
to place control points on the input object using a
reference object that already has georeference con-
trol. In the exercise on page 3, you opened 16BIT_RGB

as the input object.  Now add a reference object
using the Reference Layer Controls window.  (If the
Reference Layer Controls window is not already
open, go to the Options menu in the Georeference
window and click the Show Reference View toggle.)
Click the Add Layer icon button in the Object
Georeferencing: Reference Object View window, and
add LITEDATA / CB_DATA / CB_DLG / ROADS.

Make sure that the Add Mode check button is se-
lected in the Georeference window and that the
Crosshair tool is selected in both view windows.
Click the left mouse button on matching features,
such as road intersections, in each View to place the
crosshairs.  You can adjust the crosshair position
by dragging them or clicking the left mouse button
on a new location.  Click the Apply icon button in
the Georeference window to add a control point.

NOTICE:   the process
opens in the “Add Mode”
which lets you add control
points.

A control point locates
the same position on both
the input and the reference
objects.

STEPS
select Options / Show
Reference View in the
Georeference window
In the Reference
Object View, add
LITEDATA / CB_DATA / CB_DLG

/ ROADS

the Crosshair tool
in both View
windows should be
selected
select matching
features
click the Apply icon
button in the
Georeference window

Adding Control from a Reference Object

Use the Crosshair Tool to
position an initial control point on
a matching road intersection.

Snap to Vertex in the
Georeference

window puts the
crosshair exactly on a
road intersection.

Choose a zoom level at
which it is easy to select

a precise crosshair position

When adding initial control points, always choose features
at the outer edges and corners of the overlapping objects.
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Each time you add a control point, a numbered item
is added to the list of control points in the
Georeference window.  The same number displays
in each View
window next to
the new point’s
tick mark. Since
the ROADS refer-
ence object has State Plane georeference, the con-
trol point list shows State Plane coordinates.

After you add at least three non-colinear control
points using separate View windows, you can switch
to an Overlay View.  Add the same CB_DLG / ROADS

vector object to the Input Object View as instructed
in the STEP list on this page.  The DLG lines display
over the raster object according to the georeference
that your initial control points have established.  Now
instead of identifying common points with the
Crosshair tool in separate windows, you can use the
Corresponder tool in the overlay view.

Select the Corresponder tool in the Input Object View.
The corresponder tool is an elastic line with a ‘+’ on
one end and a “x” on the other end.  Position your
cursor on an input object feature (marked with the
‘+’ end) and drag the elastic line
to the corresponding reference
object feature (marked with the
‘x’ end). (The next exercise gives
more detail about the
Corresponder tool.)

Vocabulary: the Input Object is
the object that is being georefer-
enced (in this example, the 16_BIT

raster object). The Reference
Object is the object from which
the Georeference process gets
control information (in this
example, the CB_DLG / ROADS vector
object).

STEPS
add at least three
control points at
matching locations
using separate View
windows
add LITEDATA /
CB_DATA / CB_DLG /
ROADS to the Input Object
View window
close the Reference
Object View window
select the
corresponder tool
in the Input Object View

Control point numbers
appear with their tick marks
in the View windows.

The Overlay View

The corresponder tool lets you drag a
tiepoint line from the input object feature
(“+”) to the reference object feature (“x”).

New control points  appear
on the list in the Georefer-
ence window.

SELECTION TOOLS
Crosshair

Corresponder
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Use the Corresponder tool to add several more con-
trol points in the overlay mode.  Position the mouse
over a feature in the input object.  Then hold down
the mouse button and drag the corresponder tool’s
elastic line to the same feature in the reference ob-
ject.

IMPORTANT: always drag the tool FROM the
input object TO the reference object.

The (+) end of the corresponder tool marks the
position of the input object, and the (X) end of the
Corresponder tool marks the location on the ref-
erence object.

Click the Apply button to accept a tiepoint pair.  Click
the Redraw button, and the new control point is
used to adjust the overlay position.

STEPS
position the mouse
cursor on a feature in
the input object
hold down the left
mouse button and drag
the Corresponder tool  to
the matching feature on
the reference object
click the Apply icon
button to add the
control point
click the Redraw
button

Press the
Redraw icon
button, and the
layers are
adjusted to the
new control
information.

Click the Apply
icon button to
accept the
control point.

Drag the
Corresponder
tool to the
matching
feature on the
reference
object.

Position the left
mouse button
on a feature in
the input object.

The Corresponder Tool

The Input Object panel in the
Georeference window shows
the position of the control point in
terms of the input object.

The Reference panel in the
Georeference window shows the
position of the control point in terms
of the reference object.

With each redraw, the Georeference process uses all the control information to determine
the new overlay relationship.  If the control points don’t “agree”, you may see mismatches,
even at control point positions.  The next lesson shows how to adjust control points.
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Editing Controls let you move or adjust an existing
control point location.  First, push in the Edit Mode
radio button.  Then select the control point you want
from the list in the Georeference window.  The high-
light color of the selected control point changes in
the view window.  Use the Corresponder tool to re-
position the control point.

The Snap to Element, Snap to Vertex, or Snap to
Endpoint icon buttons tell the process to snap the
reference object end (X) of the corresponder tool to
the nearest element, vertex, or endpoint, in the ROADS

reference object.   In particular, use the Snap to Ver-
tex icon button to snap the (X) end of the
Corresponder tool to road intersections in the refer-
ence object.  Click the Apply icon button to update
the control point, and click [Redraw] to view the
change. You can click the Delete icon button to de-
lete a control point that you don’t want.

Adjust the
Corresponder
tool while using
the Edit Mode.

Keep the input object open for use in additional exercises.

The Snap to Vertex icon
button snaps the (X) end

of the Corresponder tool to the
node at the road intersection in
the reference object.

STEPS
activate the Edit
radio button
select a control point
from the list
adjust the +/X ends
of the Corresponder
tool
click the Snap to
Vertex icon button
click the Apply icon
button
click the Redraw
icon button to view
the change
select another control
point
click the Delete
Control Point icon
button to delete a control
point

Select a
control point
that you want
to edit.

Edit and Delete Control Points

When the Edit
toggle is
selected, the
Delete and
Find Selected
Point buttons
become
active.
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When you are ready to save your new georeference
control, select Save from the File menu in the Geo-
reference window.  Standard object selection dia-
logs let you name and describe your new georefer-
ence subobject.

The georeference process lets you select the coor-
dinate system and map projection for your georef-
erence control.  Your choice may be determined by
(1) the geometric characteristics of the input object,
such as a scanned map that was printed in a certain
projection, or (2) the system used by your other
project materials, such as a reference object you
use for control points.  For example, when you saved
the georeference for _16BIT_RGB, the system auto-
matically chose State Plane since that was the sys-
tem of the ROADS reference object.

You can choose any map projection consistent with
your input object.  Your output projection can be
different from your input projection.  You can view
coordinates in yet another projection and coordi-
nate system.  Thus you could enter control points
in Lat/Lon, view coordinates in UTM, and save the
georeference in State Plane.

Select Projections from the Setup menu.  In
the Georeferencing Op-
tions window, click [Set
All] to open the Coordi-
nate System / Projection
Parameter window.

STEPS
select Projections... from
the Setup menu
click [Set All...]
click [System...]
select “United States
State Plane 1927” from
the list and click [OK]

For more information on
Coordinate Systems and
map projections, also see
the tutorial booklet: Map
Projections from MicroIm-
ages, and Map Projections
— A Working Manual by
the U.S. Geological Survey
(1987).

Any one of the
Georeference
selection buttons
(such as Set All...)
opens the Coordi-
nate System /
Projection Param-
eters dialog.

Vocabulary: a reference
system for defining precise
locations on the Earth’s
surface is called a
coordinate system; a
coordinate system may be
independent or tied to a
particular map projection.

Choose the system you
want and click [OK].

Selecting Coordinate Systems

The System... button
opens a scrolling list
of available coordinate
systems.
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STEPS
click [Zone...]
select “Nebraska North”
from the scrolling list
click [OK] to accept the
selected zone
click [OK] to close the
Coordinate System /
Projection Parametrs
dialog

You can also specify values for the other projection
parameters associated with a selected coordinate
system.  In this example, select the State Plane zone
for the _16BIT_RGB raster object.

Click the Zone button to open the Zone Selection
dialog, which lists the State Plane zones for the
United States and its territories.  Select “Nebraska
North” from the scrolling list and click [OK] to ac-
cept it.  “Nebraska North” will be displayed in the
text box beside the Zone button.

The default projection parameters, including the pro-
jection, datum, and ellipsoid, are displayed in other
text fields.  Detailed projection control fields  can be
viewed when the Projection Parameters check but-
ton is pushed in.  These fields differ from projection
to projection; for the Lambert Conformal Conic pro-
jection used with State Plane, these fields include
the south and north standard parallels, the central
meridian, the origin latitude, false easting and north-
ing values, and scale factor. Click [OK] to accept the
current values, and close the Coordinate System /
Projection Parameters dialog.

The georeference process
provides default Projection
Parameters for each
coordinate system and
zone you select.

Vocabulary: a device for
representing all or part of a
rounded surface on a flat
sheet is called a projec-
tion; projection parameters
include the zone, datum,
ellipsoid, orientation, and
scale settings.

Selecting Other Projection Parameters

Click [Zone...] to
open the Zone
Selection dialog.

Click “Nebraska
North” and accept it
using the OK button.

The Projection
Parameters toggle
hides / shows the
current parameter
values.

Different sets of
projection control
fields are
associated with
different map
projections.
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You can add control points using any type of geo-
referenced object as the reference object: raster,
vector, CAD, or TIN.  In this exercise we will add
control points to the _16BIT_RGB georeference by
using _16BIT_BGR as a reference object in a separate
view.

Recall that to add new control points, the Add Mode
radio button must be active.  Remove the CB_DLG /
ROADS reference layer and open a reference View
window (go to the Options menu in the Georeference
window and click the Show Reference View toggle).
Add _16BIT_BGR as the reference object.  Use the
Crosshair tools in both views to mark matching fea-
tures (see page 4).  Click the Georeference window’s
Apply button (or click the right mouse button in a
view window) to add new control points.  You can
adjust or delete a control point using the Edit Mode
as described on page 7.

Open the Reference
View window and
add _16BIT_BGR as
the reference
object.

Select matching locations using the Crosshair tool.

STEPS
remove the CB_DLG /
ROADS reference
object
turn on the Show
Reference View toggle
in the Options menu in
the Georeference
window
click the Add Layer
icon button and add
_16BIT_BGR as the
reference object
mark additional
matching locations
using the Crosshair tools
click the Apply icon
button

Georeference a Raster Using a Raster
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The georeference process lets you using two ras-
ters in a single View window, automatically display-
ing them in complementary monochrome colors.  The
input raster displays in red-scale; the reference ras-
ter overlays in transparent green-scale, and the com-
bined effect shows in yellow-scale.  Where the im-
ages are misaligned, red and green fringes are vis-
ible along feature edges.

Close the Reference Object windows and add
_16BIT_BGR as a reference layer to the Input Object
window.  The Georeference process automatically
redisplays the two raster layers in the red/green
monochrome mode.  Scroll and zoom to view a fea-
ture edge that shows red or green fringing.  Toggle
the Hide/Show layer controls to be sure you under-
stand the relative position of the input / red feature
and the reference / green feature.  After you draw a
correlation tie point line (from red to green), click
the Autocorrelate icon button in the Georeference
window to automatically adjust the control point
position.

The Raster / Raster Overlay View

The input raster is
displayed in red-scale.

The overlay view
shows red and
green fringing along
feature edges
when there is a
spatial mis-match.Use the

Corresponder tool
to draw red-to-
green tie points
that pull fringed
features into
alignment.

Toggle the show/
hide layer controls to
view one layer at a
time to identify
feature edges.

When the two layers overlay
correctly, the view shows the image
in yellow-scale, with no red or green
fringes.

STEPS
make sure you have at
least three control
points and close the
Reference Object
windows
Add _16BIT_BGR  to
the Input Object
View window
toggle the Hide/
Show layer
controls to examine
feature locations
select the
corresponder tool
and draw a new
tiepoint line on mis-
matched features
click the
Autocorrelate icon
button to adjust  the
position of each
endpoint
click the Apply
button

The reference raster
overlay is displayed in
green-scale.
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Accurate georeferencing is important in preparing
your geospatial materials for quantitative analysis
in TNTmips.  While using any map projection se-
lected, it is important to know how well the coordi-
nates selected fit with the ideal grid.  Residuals pro-
vide a measure of how well the control points match
the ideal grid.

Residual values are the distances between the con-
trol points selected and the location of the control
points predicted by the georeferencing model se-
lected (or the deviation from the locations predicted
by the model).    If some values in the Residuals
column in the Georeference window are much larger
than most other residual values, it is an indication
that the control points selected do not fit well with
the model for the coordinate system.  Choose any
option from the Model menu to view the Residual
values.  In general, if the residual values are an or-
der or more greater in magnitude than the cell size,
your georeference control may need to be adjusted.

Note:  Many kinds of project materials naturally have
large residuals that should not necessarily be  cor-
rected by using estimated coordinates.  Airphotos,
for example, have systematic distortions of perspec-
tive and elevation so that even when control points
are accurately placed, you get high residuals, espe-
cially as elevation and distance from the center of
the photo increase.  Keep correct control points and
use that control in resampling or rectification pro-
cesses to conform the geometry of the project mate-
rials to the map projection you want.  (Refer to the
tutorial booklet  Making DEMs and Orthoimages)

Minimizing Residuals

The units in which residual
values are indicated in
parenthesis in the title of
the  Residuals Column.

STEPS
select Affine, Plane
Projective, and Bilinear
model options from the
Model menu, and
compare the residual
values associated with
each model and control
point
with the Edit Mode
active, select a control
point with a large
residual value
double check the control
point placement, and edit
the position if necessary
click the Apply icon
button and [Yes] on
the Verify window, and
notice the Residual
values for the control
points are adjusted to
conform to the ideal grid
click the Redraw
Icon button to view
the change on the View
window
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STEPS
use LITEDATA / CB_DATA /
CB_DLG / ROADS as the
input object
click [Skip] on Select
Subobject dialog
activate the Add Mode
radio button
select  a control
point location using
Crosshair tool on the
Input Object View
window
select Latitude /
Longitude coordinates
enter the coordinates in
the Latitude, Longitude,
and Elevation text fields
click the Apply icon
button

Another way to establish the georeference is by
acquiring map coordinates from global positioning
survey data, reference maps, or conventional land
survey information.  Simply locate the survey point’s
position using the mouse, and fill in the Coordinate
values as described below.   After you open the
input object (in this example, the CB_DLG/ROADS vec-
tor object), click the Skip button on the Select
Subobject dialog, activate the Add Mode radio but-
ton, and select the coordinate system used by your
source of data in the Georeferencing Options dia-
log.  Use the Crosshair tool and the Input Object
View window to select the location by positioning
the mouse cursor, and click the left mouse button at
the desired location on the View window.  Next enter
the known Coordinate values (see illustration be-
low) in the Reference numeric fields on the
Georeference window.  Then click the Apply icon
button to accept the settings, and add the new con-
trol point.

Enter Known Coordinates

Click the Apply icon button.

Enter the
Coordinates.

 Use the Add Mode radio button.
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STEPS
choose the Make Simple
option from the File menu
select the United States
State Plane (1927)
projection and Nebraska
North zone
assign the Reference
Point location as shown
below
set the Orientation type,
the Coordinates, and Cell
Size values as shown
below
click [Run... ] and select
the LITEDATA / CB_DATA /
CB_COMP / 16BIT_RGB

raster object from the
CB_DATA Project File
click [Close]

You may know the coordinate system, cell size, and
coordinates for a corner or central cell location from
reference materials supplied by the source of your
raster object.  You may be able to determine such
parameters using a reference map; you can select
the Make Simple option on the main Georeference
window to open the Create Simple Raster
Georeference dialog.  For this exercise, open that
dialog, click the Projection button, and use the Co-
ordinate System / Projection Parameters and associ-
ated windows to select the United States State Plane
(1927) and the Nebraska North projection and zone.
You can then create a simple georeference subobject
if you select Upper Left as the Reference Point, se-
lect Projection Upright from the Orientation option
menu, enter the coordinate values “162834.38” and
“333324.33” in the Northing and Easting numeric
fields, and type “28.5” in both Cell Size numeric
fields.  Then, click [Run...] and use the standard File
/ Object Selection process to select the CB_COMP /
16BIT_RGB raster object from LITEDATA / CB_DATA.
When complete, the message line displays the mes-
sage, “Georeference saved...” and the Simple
Georeference subobject is saved.  Then click the
Close button.

Use the Make Simple option
to georeference rasters
when you know the
coordinate system, cell
size, and coordinates for a
corner or center location.

select the
Projection...

designate the
Reference Point

set the Orienta-
tion

enter the
Coordinates

enter the Cell
Size

click [Close]

click [Projection...]

Simple Georeferencing

click [Run...]
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When you are satisfied with the correspondence of
the input object with the reference materials, always
save your work before exiting the process.  When
the georeference subobject has been saved, the text
“Georeference Control Points Saved...” appears in
the message line at the bottom of the Georeference
window.  The georeference control points, coordi-
nates, and associated parameters specific to the se-
lected coordinate system / map projection that you
created are saved as a subobject for future use with
the parent object.  Select Exit from the File menu in
the Georeference window to close the window and
exit the Georeference process.

Refer to the Georeferencing section of the
TNTmips reference manual for information on Make
Implied georeferencing for vector, CAD, and TIN
objects; reading from and saving as text files;
georeferencing models; digitizing; using residuals;
and other georeferencing options.

Learn more about selecting and using map projec-
tions in the TNT products with the companion tuto-
rial booklet  Map Projections.

Other References

What Next?
Each object in your project
materials needs only one
georeference subobject. If
you create an additional
georeference subobject,
you should delete any older
georeference subobjects
and thereby prevent
subsequent confusion
about which one is the
"good" one.

STEPS
select Save from the File
menu
use the standard File /
Object Selection
process to designate a
name and description for
the georeference
subobject you have
created
select the Exit option
from the File menu to
close the Georeference
window and exit the
Georeference process

Cromley, Robert G. (1992) Digital Cartography, New Jersey, Prentice-Hall, Inc.
pp. 10-18.

U.S. Geological Survey, (1987).  Map Projections — A Working Manual, U.S.
Geological Survey Professional Paper 1395, Washington, DC, U.S.
Government Printing Office.

Wolberg, George (1990). Digital Image Warping,  Los Alamitos, California:
IEEE Computer Society Press. 318 pp.

Wolf, Paul R. (1983). Elements of Photogrammetry, Second Edition. New York:
McGraw-Hill. pp. 597-601.
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Voice: (402)477-9554
FAX:  (402)477-9559

MicroImages, Inc. publishes a complete line of professional software for
advanced geospatial data visualization, analysis, and publishing.  Contact us
or visit our web site for detailed product information.

TNTmips TNTmips is a professional system for fully integrated GIS,
image analysis, CAD, TIN, desktop cartography, and geospatial data-
base management.

TNTedit TNTedit provides interactive tools to create, georeference,
and edit vector, image, CAD, TIN, and relational database project
materials.  TNTedit can access geospatial data in a wide variety of
commercial and public formats.

TNTview TNTview has all the same powerful display features for
complex visualization and interpretation of geospatial materials as
TNTmips. TNTview is perfect for those who need flexible access to the
TNT project materials but do not need the technical processing and
preparation features of TNTmips.

TNTatlas TNTatlas lets you publish and distribute your spatial project
materials on CD-ROM at low cost. TNTatlas CDs contain multiple
versions of the TNTatlas software so that a single CD can be used on
any popular computing platform.

TNTserver TNTserver lets you publish TNTatlases on the Internet or
on your intranet.  Navigate through massive geodata atlases with your
web browser by using the free, open-source TNTclient Java applet (or
any custom applet you create) to communicate with TNTserver.

TNTlite TNTlite is a free version of TNTmips, TNTedit, and
TNTview for students and professionals with small projects. You can
download TNTlite for your computer (about 100MB) from MicroImages’
web site, or you can order TNTlite on CD-ROM (shipping charges
apply).

email: info@microimages.com
Internet: www.microimages.com

11th Floor – Sharp Tower
206 South 13th Street
Lincoln, Nebraska  68508-2010 USA


